
We start this month’s newsletter with some sad news.  After 102 monthly articles spanning nine years, SumProduct’s Spreadsheet Skills articles for 
CIMA Insight (the magazine for Chartered Institute of Management Accountants, but freely available to all) has ceased.  This is not due to the series 
being retired.  Indeed, the articles remain as popular as ever.  Unfortunately, the magazine has ended and has been subsumed by the American 
Institute of Certified Public Accountants’ (AICPA’s) CGMA (Chartered Global Management Accountant) Magazine.

Back in June, we noted that Microsoft had added a new feature 
to help users co-author files.  Whether you are for or against this 
feature was not the point: it needed Excel's AutoSave switched 
on to work.  That's fine.  But we didn’t want it to be the default.  
Whilst it is accepted that Office is trying to make various apps 
consistent, we observed that Excel has been and always will be 
used differently.  What makes it the most popular software in 
the world is the ability to experiment without consequences. 
Made a mistake?  No fear, close without saving and re-open.  
Accidentally delete a sheet?  Don't worry, close without saving 
and re-open.  Replaced all formulae with =RAND()? etc. etc.

For those working in the Cloud, yes you can restore earlier 
versions - when it works.  But many don't.  And some can't 
(no internet, company policies, etc.).  All we asked was for the 
ability to switch AutoSave off at a global level, so we didn’t get 
inadvertent date / time stamps or have to switch AutoSave off 
for every file as we open them.

The king is dead; long live the king!  

All previous readers will be transferred to the new magazine, but it does 
mean we attract an ever-larger readership.  So, if you have joined us as a 
result of discovering the Excel series in CGMA Magazine, welcome board 
and apologies for the inherent sense of humo(u)r.  Sorry, we just can’t 
bring ourzelves 2 tipe in an Americum weigh (sic).

There is one associated, disappointing observation though.  Due to the 

timing of the transfer, it’s too late to coordinate the usual Christmas Quiz 
that we have run for the past eight years.  Hopefully, it will return in 
2018.

You can read our first article for CGMA Magazine at www.cgma.org/
magazine/2017/nov/excel-if-function-201717851.htm.
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469 articles, 342 keyboard shortcuts,  
37 readers’ questions and 535 pages later  
we have made it to the grand old age of five years old!  It will be time to go to school soon.  

As usual, we note the Power BI Desktop and Service updates, and there’s good news too for those who want to share 
Power BI externally and for those of us who hate AutoSave.  There’s the usual features (Power Query Pointers and 
Keyboard Shortcuts) too.

However, given it’s our fifth birthday, we thought we’d dust off some of the articles we have previously shared.  It’s a 
subjective selection, but hopefully, it will strike a chord with our “Blast from the Past” articles.

Until next month.

Goodbye CIMA / Hello CGMA

With a Little Help from Our Friends
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It's not often we take action but we did resort to Excel User Voice. The 
votes have steadily increased, but Microsoft has remained eerily silent.  
No matter – we held out for a hero and “Anonymous” delivered (probably 
some Microsoft employee presumably fed up with the mass whingeing!).  
We have a workable solution!!

Here’s how to disable the AutoSave feature in Microsoft Office 365 
ProPlus.  As we have already stressed, this feature applies to each 
document.  It can't be disabled on the application level.

This approach requires you to modify the registry.  However, serious 
problems might occur if you modify the registry incorrectly.  Therefore, 
make sure that you follow these steps carefully and SumProduct will 
not be held responsible for any issues caused whatsoever.  It is strongly 
recommended that for added protection, back up the registry before 
you modify it.  Then, you can restore the registry if a problem occurs. 

Backing Up the Registry

Disabling AutoSave

Windows 7 Windows 8, 8.1 or 10

You may back up the registry manually or create a system restore 
point.

Manually

Click ‘Start’, type regedit.exe in the search box and then press ENTER.  
If you're prompted for an administrator password or for confirmation, 
type the password or provide confirmation.

In the Registry Editor, locate and click the registry key or subkey that 
you want to back up.

Click File > Export.

In the ‘Export Registry File’ dialog box, select the location to which 
you want to save the backup copy and then type a name for the 
backup file in the ‘File name’ field.

Click ‘Save’.

System Restore Point

Right-click the ‘Start’ button, then select Control Panel > System and 
Maintenance > System.  In the left pane, select ‘System protection’.  
Select the ‘System Protection’ tab, and then select ‘Create’.  In the 
‘System Protection’ dialog box, type a description and then select 
‘Create’.

Restore the information based on which backup method you used.

Restoring from Manual Backup

Click ‘Start’, type regedit.exe in the search box and then press ENTER.  
If you're prompted for an administrator password or for confirma-
tion, type the password or provide confirmation.

In the Registry Editor, locate and click the registry key or subkey that 
you want to back up.

Click File > Import.

In the ‘Import Registry File’ box, select the location in which you 
saved the backup copy, select the backup file and then click ‘Open’.

Restoring from Restore Point

Right-click the ‘Start’ button, then select Control Panel > System and 
Maintenance > Backup and Restore.

Select either ‘Restore my files or Restore all users' files’.

You may back up the registry manually or create a system restore 
point.

Manually

From the ‘Start’ menu, type regedit.exe in the search box, and then 
press ENTER.  If you are prompted for an administrator password or 
for confirmation, type the password or provide confirmation.

In the Registry Editor, locate and click the registry key or subkey that 
you want to back up.

Click File > Export.

In the ‘Export Registry File’ dialog box, select the location to which 
you want to save the backup copy and then type a name for the 
backup file in the ‘File name’ field.

Click ‘Save’.

System Restore Point

From the ‘Start’ menu, type create a restore point.  Select ‘Create a 
restore point’ from the search results.  Choose ‘Create’ and then fol-
low the steps to create a restore point.

After you've backed up the information, restore it based on the 
method you used.

Restoring from Manual Backup

From the ‘Start’ menu, type regedit.exe, and then press ENTER.  If 
you are prompted for an administrator password or for confirmation, 
type the password or provide confirmation.

In Registry Editor, click File > Import.

In the ‘Import Registry File’ dialog box, select the location to which 
you saved the backup copy, select the backup file and then click 
‘Open’.

Restoring from Restore Point

From ‘Start’, type ‘Create a restore point’.  Select ‘Create a restore 
point’ from the search results.  Choose ‘System Restore’.

To disable AutoSave, you need to access the Windows registry.  From ‘Start’, type regedit and then press ENTER.  Through the opened Windows 
registry, add a DWORD value of 1 to each of the following registry subkeys for the indicated Office 2016 ProPlus (Subscription) application:

The DWORD value of 1 disables AutoSave.

Application Registry Subkeys

Excel HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\16.0\Excel\DontAutoSave

PowerPoint HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\16.0\PowerPoint\DontAutoSave

Word HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\16.0\Word\DontAutoSave
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Microsoft publishes various useful tricks and tips for Excel from time to time on its “Office Blogs” web site.  Back in 2013, SumProduct’s Liam Bastick 
was invited to write an article on summing data based on multiple criteria on multiple worksheets.  The formula is pretty ugly, but it proved to be 
ranked the fourth favourite Excel blog of 2013:

Blast from the Past: Go Fourth and Multiply

It is reproduced below here.

Working with multiple criteria on multiple Excel worksheets is a common problem.  This has been quite a popular topic and it is clear that the answer 
to this particular question isn’t that easy to come by.  In fact, a lot of so-called experts say it can’t be done in Excel alone.  Well, we specialise in the 
impossible!  Allow me to explain my solution using an illustration from an Excel file that may be downloaded from www.sumproduct.com/thought/
multiple-multiple-criteria.

Let us imagine we run a car sales company with four divisions: North, South, East and West.  Sales are reported in a similar fashion for each (North 
and South divisions are shown below):

The month, associated sales person, car colour and cash amount of each sale is recorded.  Note that the reports of each division may not be of equal 
length, but importantly the column headings of each table are in the same column of each spreadsheet (e.g. the month is always recorded in column 
F, the salesperson is always in column G, etc.).  This is necessary for my solution to work.

Let’s build up the problem slowly.

North Report South Report

Single Criterion, Single Data Source

I appreciate many readers will find this trivial, but for completeness I shall start here.

Single Criterion, Single Source
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This is a simple use of the SUMIF function.  For example, the formula in cell G12 in the illustration above is: 

=SUMIF(North!$F:$F,$F12,North!$I:$I)

where North is the Excel worksheet containing North division’s sales data.  Alternative functions can be used but I am sticking with SUMIF as I will 
be using this and its sister function (SUMIFS) throughout this example.  Essentially, all sales are added when the month of the sale matches the 
reporting month.

Again, there are many ways to solve this conundrum, but the one I have chosen has the following formula in cell I12:

=SUMIFS(North!$I:$I,North!$F:$F,$F12,North!$G:$G,$G12,North!$H:$H,$H12)

Here, I have used the SUMIFS function, which deals with multiple criteria, here only summing data where the month, salesperson and car colour 
match the required criteria.  Some may be amused to see I do not recommend our company’s namesake, SUMPRODUCT, here, but this function 
would not work on an entire column prior to its revision in Excel 2007.

Now, it gets more fun...

Multiple Criteria, Single Data Source

Single Criterion, Multiple Data Sources

The next logical step is to increase the number of criteria (but still focus on just the one data source):

Rather than make the jump to multiple criteria and multiple data sources all in one go, I thought it would be better to introduce one complication 
at a time:

Before explaining the formula in G12 here, I would like to recommend an interim step.  If I am to refer to multiple datasheets, I need to know the 
names of these worksheets.  I suggest storing the worksheet names in a Table:

Multiple Criteria, Single Source

Single Criterion, Multiple Sources
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In the associated Excel file, this Table has been named Division_Table as this lists the divisions relevant for the analysis.  It is intentional that I have 
not included all four divisions, but it is also important to note that the three divisions named (North, South and East here) must have identical names 
to the sheet tab names – otherwise, this solution will not work.

Tables represent a useful functionality, first introduced into Excel 2007.  Essentially, by listing data this way it allows users to add to the list (by 
putting, say, ‘West’ on the next line in my illustration) such that any referencing formulae will update the referenced list automatically.

Returning to this third example, namely multiple criteria based upon a single data source, the formula in cell G12 of my illustration is a little more 
sophisticated than the first two solutions:

=IFERROR(SUMPRODUCT(SUMIF(INDIRECT("'"&Division_Table[Relevant  
Divisions]&"'!F:F"),$F12,INDIRECT("'"&Division_Table[Relevant Divisions]&"'!I:I"))),)

You know you have created a monster when you nest three Excel functions inside a fourth.  To work out what is going on, I will explain from the inside 
out (as this is how Excel will calculate this formula):

	 •	 INDIRECT – This function produces an array of references such as ‘North’ column F, ‘South’ column F, etc. which can be used by the other 	
		  functions.  Note carefully that “’” in the formula is inverted commas followed by an apostrophe (the syntax required in general for sheet names)  
		  followed by inverted commas

	 •	 SUMIF – This function now applies the single criterion to the summation analysis.  However, since it is not an array function, this will only report  
		  on one worksheet at a time (in my example, there are three sheets: ‘North’, ‘South’ and ‘East’)

	 •	 SUMPRODUCT – This function is necessary as this function is often referred to as a “pseudo array function”.  What this means in practice here 
		  is that it will allow the SUMIF function to be performed across all three worksheets.  SUMPRODUCT cannot be used without SUMIF; however,  
		  as this function does not appear to work with multiple rows of data on multiple sheets (it only seems to consider the first cell of each selection  
		  on each sheet).

	 •	 IFERROR – This error trap ensures that if a worksheet listed in the Division_Table does not exist and / or there is a blank row, the formula will  
		  not produce an #REF! error for example.

Simple, n’est-ce pas..?

Suggested Table

Multiple Criteria, Multiple Data Sources

So we now get to la pièce de résistance.  If you have overcome the last hurdle this is a pièce de cake:

The formula in cell I12 here is just an extension of the last example:

=IFERROR(SUMPRODUCT(SUMIFS(INDIRECT("'"&Division_Table[Relevant  
Divisions]&"'!I:I"),INDIRECT("'"&Division_Table[Relevant 

Divisions]&"'!F:F"),$F12,INDIRECT("'"&Division_Table[Relevant  
Divisions]&"'!G:G"),$G12,INDIRECT("'"&Division_Table[Relevant Divisions]&"'!H:H"),$H12)),)

Multiple Criteria, Multiple Sources

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Whilst the formula may look even more horrible upon first glance, essentially the SUMIFS function has merely replaced the SUMIF function, similar 
to the difference between the first two examples discussed above.

It’s not pretty, but it’s effective.

Word to the Wise

Calculating interest without circularity

Given this solution uses Tables, IFERROR and the SUMIFS functions, this will only work in Excel 2007 and later versions of Excel.  

Also, there are several other possible solutions to consider: 

	 •	 PivotTables using data from multiple worksheets
	 •	 creating a master data sheet as an interim step, where all data is recorded on one worksheet
	 •	 use Power Pivot or Power Query / Get & Transform.

I have produced this result as a “pure” answer.  

However, I would like to stress the age-old rule: Keep It Simple Stupid (KISS).  Having data on multiple worksheets complicates the problem and may not 
be a necessary complexity.  Before writing opaque formulae such as the ones discussed above, always consider simplifying the model (structure) first.

Given this solution uses Tables, IFERROR and the SUMIFS functions, this will only work in Excel 2007 and later versions of Excel.  

Also, there are several other possible solutions to consider: 

	 •	 PivotTables using data from multiple worksheets
	 •	 creating a master data sheet as an interim step, where all data is recorded on one worksheet
	 •	 use Power Pivot or Power Query / Get & Transform.

I have produced this result as a “pure” answer.  

In a financial model, it is commonplace to have to calculate interest.  For this illustration, let’s assume we are calculating interest received on the 
business’s average cash balance for certain periods of time (it could just as simply be interest paid on a debt balance, etc.).  This gives rise to a 
perceived circular logic:

Back in the early days of the SumProduct website, this article was one of the most popular topics and is still requested by many.  We thought we’d 
give it another airing here.

When a formula refers back to its own cell, either directly or indirectly, it is called a circular reference.  Microsoft Excel cannot automatically calculate 
all open workbooks when one or more of them contains a circular reference and usually will put zero as the default value in the cell(s) instead.

You can remove a circular reference, or you can have Excel calculate each cell involved in the circular reference using the ‘calculate iterations’ 
feature.  This requires you enabling iterations:

	 •	Go to Excel Options (ALT + T + O)
	 •	 Choose ‘Formulas’ from the list in the left-hand column
	 •	 In the first section, ‘Calculation options’, ensure the check box ‘Enable iterative calculation’ is checked
	 •	Amend the Maximum Number of Iterations (maximum is still 32,767) as required
	 •	Amend the Maximum Change as required (the smaller the number, the longer it will take for Excel to calculate the answer)
	 •	 Click ‘OK’.

Various problems may arise with circular references:

	 •	Many users will agree that circular arguments can cause the Excel file to become unstable and even crash;
	 •	When solved, Excel may give one solution when there may be several, only one of which is correct in the given circumstances.  If the proble 
		   is not fully understood, the danger is an incorrect solution may be accepted;
	 •	 If Excel stops calculating after a given number of iterations / when the difference between iterations becomes miniscule, users expect the  
		  resulting values to be a solution when it may not be (you must always verify that the value reported provides the result required).

Therefore, circular arguments are not recommended, although it is conceded on occasion there may be no alternative viable solution.

Blast from the Past: Avoiding Circularity When Modelling Circularity
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This problem can be solved algebraically in, er, a relatively straightforward manner without creating circularities – and is therefore our recommended 
approach.  

In a newsletter, we wouldn’t normally publish the following, but the derivation of the formula has proved to be one of our most popular web pages 
(see www.sumproduct.com/thought/interest-received).  Therefore, we apologise for the following mathematical assault (for those not interested in 
the derivation, simply skip to the end) – unfortunately, Excel modelling sometimes boils down to solving simultaneous equations!  

Let:

	 OB	 =	 opening cash balance for the period

	 CB	 =	 closing cash balance for the period

	 M	 =	 non-interest cash movement for the period

	 I	 =	 interest cash movement for the period

	 r	 =	 interest rate

	 t	 =	 tax rate (it is assumed this cannot equal 100%)

	 x	 =	 proportion into the period that the non-interest cash movements are assumed to occur, e.g.

	 	 	 	 •	 If x = 0%, this means the movement occurred at the start of the period
	 	 	 	 •	 If x = 100%, this means that the movement occurred at the end of the period
	 	 	 	 •	 If x = 50%, this means that the movement occurred midway through the period

So, 	 CB	 	 =	 	 OB + M ( 1 – t ) + I ( 1 – t )	 	 and	

	 I ( 1 – t )		 = 	 	 ( x.OB + ( 1 – x ).CB ).r.( 1 – t )	 so (as t ≠ 100%)

	 I	 	 = 	 	 ( x.OB + ( 1 – x ).CB ).r

	 	 	 =	 	 ( x.OB + ( 1 – x ).( OB + M ( 1 – t ) + I ( 1 – t ) ) ).r

	 	 	 =	 	 OB.r + ( 1 – x ).M.( 1 – t ).r + ( 1 – x ).I.( 1 – t ).r

Therefore,

	 	 I.( 1 – (1 – x ).( 1 – t ).r ) 	 =	 OB.r + ( 1 – x ).M.( 1 – t ).r

	 	 	 <=>	 	 I	 =	 OB.r + ( 1 – x ).M.( 1 – t ).r	
	 	 	 	 	 	 	    ( 1 – (1 – x ).( 1 – t ).r )

Hence, we can calculate interest from this final equation and have no circular references or goal seek. 	
Please see www.sumproduct.com/thought/interest-received for an example Excel file that illustrates this technique:
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Back in 2015, we were “very unimpressed” with the result of the Institute of Chartered Accountants in England and Wales’ (ICAEW’s) competition 
to find the Best Excel Tip Ever.  He winning entry suggested F5 + Special to select blanks in order to paste in missing formulae.  Our readership was 
underwhelmed.  So we asked the audience for your best Excel tips.  Aside from, “Get someone else to do it”, we present below the five most popular 
ones received from back in May 2015...  

Best Excel Tip Ever – The Top Five

Is this a top tip..?

Number 5: Close Files, Not Excel 2013

Ever closed that final file in Excel 2013 or Excel 2016 only for the application to close down as well?  This is the Excel 2013+ way of the world but there 
is a workaround and we thank recent MVP awardee Wyn Hopkins once more of Access Analytic for bringing this to our attention.

In Excel 2013 / 2016, simply right-click on the Quick Access Toolbar and select ‘Customize Quick Access Toolbar…’ viz.

In the subsequent dialog box, select ‘All Commands’ in the ‘Choose commands from’ drop down box and then select ‘Close’ (with the folder icon, 
please see the illustration below).  Next, click on the ‘Add>>’ button to add it to the Quick Access Toolbar and finally click on ‘OK’ to exit the dialog box.

From now on, simply click on this ‘Close’ icon in the Quick Access Toolbar and you will never have to say goodbye to Excel 2013 or Excel 2016 again.  
Breaking up can just be so very hard to do!
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Number 4: Finding Inconsistent Formulae Easily

Kim Ho and Minh Lee were two that suggested this one.  Consider the following block of data:

Let’s assume this data is supposed to refer to a similar block of data elsewhere.  How can we tell if the formula has been copied across and down 
correctly?  Inspection by eye achieves nothing here.  

One option is to use the keyboard shortcut CTRL + ` (the character is the key to the left of the 1 on a standard QWERTY keyboard):

This shortcut toggles cell values with their content (i.e. formulae).  This will show formulae which have not been copied across properly, but this is 
still fraught with user error (can you spot the relevant cells?) and would be cumbersome with vast arrays of data.

Instead, there is a simpler, automatic approach.  Select all of the data (click anywhere in the range and press CTRL + * – see below for more on this 
shortcut).  Then use the keyboard shortcut CTRL + \ viz.

This automatically selects all of the cells whose contents are different from the comparison cell in each row (for each row, the comparison cell is in 
the same column as the active cell).

CTRL + SHIFT + \ selects all cells whose contents are different from the comparison cell in each column (for each column, the comparison cell is in the 
same row as the active cell).  In this example, where a formula is supposed to be copied across and down, there will be no difference.

These cells can now be highlighted and reviewed at leisure.
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Number 3: The 39 Steps of Range Names

Number 2: Selecting an Active Range

Number 1: Demonic Data Validation

Excel MVP Bob Umlas was a great proponent of the following tip for identifying range names quickly.  We first brought this to your attention in last 
July’s newsletter.

An interesting quirk relating to range names is what happens if you actually reduce the scale of Zoom View (ALT + W + Q) to 39% or below:

Interestingly, this one was most popular with the Excel MVPs, including Ken Puls and Frederic le Guen.  Consider you have been working with an 
Excel range.

We have some twisted individuals reading this newsletter!  By far and 
away the most popular ‘trick’ (in all sense of the word!) was this monster 
first divulged in our very first newsletter by our own resident MVP Liam 
Bastick.  We have elected not to name all the people who suggested 
this – partly to save printing costs and partly to protect the guilty.  You 
know who you are!!

Data Validation is a useful way to control what end users can type into 
a worksheet cell (see www.sumproduct.com/thought/data-validation).  

You can use this functionality to play a trick.  Please use this at your own 
risk: if you get fired, you will get no sympathy here and we will disown all 
knowledge: this article will self-destruct in five seconds...

If someone is unfortunate to leave a spreadsheet unprotected, simply 
highlight the whole worksheet and then activate Data Validation (ALT + 
D + L).  In the ‘Settings’ tab, select settings similar to the following (the 
aim is to pick a number the user won’t use):

Clicking anywhere in this range and then pressing CTRL + * will then select the whole range,

It can be a simple way of tracking down some of those pesky critters.
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Then, select the ‘Error Alert’ tab:

If you are feeling particularly horrible, add “Press any key to continue” to this message for maximum effect.  Now, de-select the range and wait for 
your victim to use the worksheet.  As soon as they type an invalid entry, they will be greeted with the following error alert:

Who says spreadsheets can’t be fun..? 
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For users already familiar with Power Pivot and Data Analysis eXpressions 
(DAX, the associated programming language), it might seem logical that 
Power Query would use a similar language and perhaps even the same 
formulae.  Not so.  Power Query has its own language, M, and its own 
formula syntax.  There’s not even a clever reason why the language is 
called M, it was just the next available letter.  So, having abandoned any 
expectation of familiarity, let’s find a good place to start looking at M 

language (after L?).  To begin with, let’s create a custom column and look 
at a formula that can be associated with that new column.    

In this example, I’ll start out in the worksheet for the merged query I 
created in an earlier article and open ACCT_Order_Charges_with_Group 
to access the query editor.  On the ‘Add Column’ tab I choose to ‘Add 
Custom Column’:

The dialog box has a large section for the formula beneath the name you 
may choose for the new custom column.  Available columns in the query 
are shown and double clicking them adds them to the formula (or you 
can select and then choose to ‘Insert’ them).

Notice the option to ‘Learn about Power Query formulas’ at the bottom 
of the dialog box.  This is the best place to find out what formulae are 
available in Power Query.  Clicking here will take you to the Microsoft 
help page, which has a links to find out lots about Power Query M 
language and the functions available. 

Having said that, the formulae do not tend to match those for Power 
Pivot, although there are some functions that are reassuringly familiar 
from Excel, as I will show now by concatenating two existing columns.

I’ll create a column that combines the Item_Group and the Description 
columns by double clicking each column (or using ‘Insert’). I type in an 
‘&’ between the columns, which is the same as I would do in an Excel 
formula, and include a ‘/’ to separate the data in the column to make it 
easier to read:

Click ‘OK’ and the custom column is generated, ready to be loaded to the worksheet.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month we delve into M, the programming 
language behind Power Query.

Power Query Pointers
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There are other similarities with Excel: the symbols ‘+’, ’-‘, ’*’ and ‘/’ are used for add, subtract, multiply and divide respectively too. 

There are however some points to bear in mind when comparing Power Query formulae with Excel:

	 •	 Excel formulae are not case sensitive, but Power Query formulae are
	 •	 Excel counts using a base of 1 (e.g. the first letter in a string is at position 1), but Power Query uses a base of 0 (zero) (so the same letter would  
		  be at position 0)
	 •	 Excel will automatically convert data (e.g. concatenating a text column to a numerical column will work as Excel converts them to text  
		  automatically).  Power Query will not (e.g. trying to concatenate text to a value will give errors in the new column – the value must be converted 
	  to text first).  This is why I picked two text columns for my example above. 

Having imparted some good news and some bad news about the way that Power Query and M language compares with Excel, next month we will 
look in more detail at how M language is constructed.

If you are using Power BI, then this may be of interest to you.  In Power BI, “apps” bring related dashboards and reports together.  People throughout 
your business / organisation may create and distribute apps with key business information.  External services, such as Google Analytics and Microsoft 
Dynamics CRM, also offer Power BI apps. 

Apps are located in and installed from the Power BI service (powerbi.
com).  After you have installed an app, you don't have to remember the 
names of a lot of different dashboards because they're all together in 
said app, either in your browser or on your mobile device.
The recent general availability of Power BI Premium in June broadened 
the service’s reach, allowing organisations to distribute BI content broadly 
without requiring recipients to be licensed individually.  Accessibility has 
been extended further: now, Power BI users can seamlessly distribute 

Power BI apps and dashboards to guest users outside of their organisation 
– recipients are able to securely sign into the service using their own 
organisation’s security credentials or personal email address, while the 
content owner is able to maintain control over the internal data.
This new feature is the result of Power BI integration with something 
called Azure Active Directory (AD) business-to-business (B2B) 
collaboration.

Power BI Expands Access to Business Intelligence for External Guest Users
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For example, consider a scenario where an automotive manufacturer 
working with many diverse suppliers wants to streamline its supply 
chain logistics: all the components, materials and services necessary to 
run its manufacturing operations.  The company plans to use Power BI 
to monitor key supply chain performance metrics by building a BI portal 
its employees and partners can access.  Previously, this would mean 
that the manufacturer would have needed to create duplicate identities 
for users belonging to partner organisations, requiring those users to 
remember multiple sets of credentials, and creating challenges for 
governance enforcement and identity management.  Alternatively, the 
automaker could have invested the time and cost of building an app with 
Power BI Embedded that employs custom authentication.

In this latter instance, Power BI’s integration with Azure AD B2B enables 
seamless, secure access for guest users from partner organisations: the 
automaker can create a Power BI app in the service, invite guest users, 

and distribute the BI content to them to access by authenticating via 
their organisation’s Azure AD credentials.

External users can be licensed to receive BI content in two ways:
	 1. the content is allocated to Power BI Premium capacity
	 2.	 the external user is assigned a Power BI Pro license.  In this instance,  
		  this can be done by either the external user's administrator or, as 	
		  a new capability, by the sharing organisation's administrator.

Power BI integration with Azure AD B2B provides allows entities to 
employ established Azure AD authorisation policies to protect their 
data, including conditional access policies and risk-based authentication.  
Administrators are also able to set policies for external B2B invites, such 
as the ability to turn off or restrict the ability for users to send invitations.  

No more dual email addresses!

November’s update saw conditional formatting getting a major update, with the ability to control the color based on rules.  Further, if you have a slow 
data source, there are now report options that help restrict the number of queries that are sent to the source.  Finally, there’s also several formatting 
features added, including cell alignment for table and matrix and precise control over the order of overlapping charts on your report.

In summary, the list of updates are as follows:

Power BI Desktop November Update

Reporting

Analytics Data connectivity

Query editing

Rule-based conditional formatting for table and matrix

	 •	 Rule-based conditional formatting for table and matrix
	 •	 Cell alignment for table and matrix
	 •	 Control visual ordering through the selection pane
	 •	 Lock objects on your report
	 •	 Esri Plus Subscription available for ArcGIS Maps for Power BI
	 •	Report options for slow data sources

	 •	 Filtering performance improvements
	 •	Recently released custom visuals: 

	 	 	 o	 Image Timeline
	 	 	 o	 Social network graph
	 	 	 o	 Venn diagram by MAQ Software
	 	 	 o	 HTML viewer

	 •	Cell-level formatting for multidimensional AS models for 	
	 	 multi-row card

	 •	 Impala connector – support for Windows Authentication

	 •	Add Column From Examples improvements.

Let’s take a look at each of these in turn.

This latest update saw conditional formatting include rule-based conditional formatting.  Now, if you have specific business logic to reflect in your 
table or matrix, you may create rules to conditionally colour the background or font color of a column (yes, the missing “u” is deliberate!).

To start formatting based on your rules, simply open the ‘color scales’ dialog and check the ‘Color by rules box’.  This enables you to choose colours 
by your required logic.
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In each rule, you can pick a colour to use when a cell value is between two values, is equal to a specific value or is blank:

When finished, click ‘OK’ to apply your rules.   Each rule is applied in order, top to bottom. This means that if a value meets the criteria of two different 
rules, the bottom rule applies.  It should be noted that this is different to how it works in Excel.

Cell alignment for table and matrix

This update has added cell alignment control to table and matrix visuals.  You can specify left, right, or centre alignment for your row and column 
header or you can set the alignment for one specific field in the ‘Field formatting’ card:
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Control visual ordering through the selection pane

Lock objects on your report

Esri Plus Subscription available for ArcGIS Maps for Power BI

The October update introduced the selection pane, which allowed users to easily select all the objects on their report page.  It also allowed control 
if the object were visible.  This pane is now enhanced to let you easily change which overlapping objects show on top on the canvas.  The selection 
pane is sorted so the objects higher in the list show in front of objects lower in the list.  You can drag and drop to change the order or use the arrows 
on the top of the pane to move things up and down.

When you’re interacting with a report, either to test it out or as part of the analysis process, it’s easy to accidently nudge a chart a little to the left 
or right.  To help with this problem, Microsoft has added a button to the ‘View’ tab to lock all the objects on the report.  This will turn off resize and 
move, so you no longer have to worry about messing with your layout as you interact with your report.  Unfortunately, this setting isn’t saved with 
the report, so you’ll need to enable it any time you want to use it.  Great.

Esri's ArcGIS Maps for Power BI was announced at Ignite 2016 and became generally available in June this year.  Now, Esri is releasing a new 
subscription service called ‘Plus’ that enables ArcGIS Maps for Power BI users to do more with their geospatial data.

Using Plus, there are richer mapping capabilities than the ‘usual’ map, including:

	 •	More street address geocodes - up to 5,000 data points per map
	 •	Additional basemaps, including: 
			   o	 Imagery
			   o	 Imagery with labels
			   o	 National Geographic

	 •	 Living Atlas reference layers that help add more context to your maps

	 	 	 o	 Oceans, Terrain with labels
	 	 	 o	 Topographic
	 	 	 o	 USA Topo Maps
	 	 	 o	 USGS National Map (USA)
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	 •	World Demographics within the Infographics feature for categories like Education, Population, Income, or even Segmentation.

To start using Plus, all you need to do is sign up for a subscription or sign into an existing one through the plus button on the top right of the screen:

You can try the Plus subscription for 60 days at no charge and after that you can subscribe for US$5 per user per month.  There is an issue here 
though: when you use Plus features within the map, any user you share the report with needs to also have a Plus subscription to view the content.  
We can see this being a problem.

Report options for slow data sources

If you are working with either a very large or very slow data source in DirectQuery, some actions will take a while to get a response from the 
underlying data source.  To help with that, the latest update provides some options in the report to send fewer queries, making it easier to interact 
with the report.  To access these options, go to the ‘Options’ dialog under File > Options and settings > Options, and select ‘Query reduction’:

From here, you can turn off cross highlighting automatically throughout your whole report.  (You may still manually turn it on for specific visuals using 
the Visual interactions feature, but the default will be off.)

You can also add an ‘Apply’ button to slicers and filters.  Depending on what you select, the ‘Apply’ button is added to slicers, filters or both.  You 
can make as many selections as you want, but no queries will be sent until you select the ‘Apply’ button.  Your selections will then be used to filter 
all of your data.

These changes will apply to your report while you interact with it in Power BI Desktop as well as when your users consume the report in the  
Power BI service.
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Filtering performance improvements

Image Timeline

Social network graph

There are also some updates in Power BI’s filtering implementation, which improves performance for certain scenarios, such as when using strings.  
It’s worth noting that Microsoft has now removed the 500-value limit on how many values you may match when filtering for all data sources, except 
for Live connections to analysis services models.

As always, there’s new custom visuals recently released to the custom visuals store.  These may be imported directly from the store in Desktop or 
you can individually download visuals from the custom visuals store.  The first custom visual here, Image Timeline, displays events along a horizontal 
timeline.  These events can either be represented as a circle or a custom image.  You can then click on events to filter down your report to that event.  
If you have lots of events on your timeline, it also has an interactive date “brush” that lets you zoom in on the timeline.

The Social network graph custom visual can be used for visualising connections between people.  One common scenario for this is visualising 
an organisation structure where employees report to managers in a hierarchy.  You create the visual by giving it the source and target for each 
connection, and then you can format it with size and color based on other fields in your model.

We might start using it for our debtors list and publish it each month in our newsletter along with home addresses and any embarrassing facts we’ve 
unearthed…
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Venn diagram by MAQ Software

HTML viewer

Cell-level formatting for multidimensional AS models for multi-row card

Impala connector – support for Windows Authentication

This one will keep our MD happy.  Venn diagrams are good for finding commonality between different categories.  Each circle is a collection of data 
points for a given category and where the circles intersect, there are data points that represent both categories.

This one could be very useful.  The HTML viewer visual lets you display your HTML text strings in its original formatting.  You can also do some basic 
formatting of alignment, colour and size for the text.

Here’s an example comparing the HTML text in a Power BI table and the HTML viewer visual:

The latest update extends cell-level formatting support to multi-row cards.  This means that for table, matrix, single value card, and multi-row cards, 
cell-level formatting defined in the multi-dimensional Analysis Services (AS) model will automatically flow through and be applied.

Support has also now been added for Windows Authentication to the 
Impala connector.  Apparently, this was a common request from existing 
Impala connector users.  Microsoft has further promised that they will 
soon add support for Windows authentication to the On-premises data 
gateway, as well as Kerberos-based Single Sign-On support for the Impala 
connector via the Gateway too.

After specifying an Impala cluster to connect to from Power BI Desktop, 
users may now select Windows as the authentication type in the 
‘Credentials’ dialog.  Within the Windows authentication option, users 
may select whether to use the “current Windows user” or impersonate 
(!?) a different user.
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Add Column From Examples improvements

Now this is one of our favourite toys in Power BI.  Microsoft has now added support for generating “Conditional Columns” transformations as part of 
the “Add Column From Examples” experience.  This addition opens up a lot of additional scenarios for “Add Column From Examples”:

	 •	Basic Conditional Column: It is now possible to define a mapping between values in an input column and the desired output by providing a 	
		  set of examples

	 •	 Conditional Column Ranges: It’s now possible to define a new column with non-uniform ranges based on an input column.  This new capability	
	 	 is supported for columns where the output values don’t encode the range boundaries
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	 •	Null fall-back: A very common scenario for “Conditional Column” is using a value from a given column, or the value from a fall-back column 	
	 	 when the first column value is missing for a given row

•	 Bucketing (uniform ranges): “Bucketing” is now enabled via “Add Column From Examples”.  Users may now specify the upper / lower boundaries 	
	 of a range for a certain row and Power BI will automatically extrapolate to all other rows by using uniform ranges. 

For those who require an on-premises solution for reporting (and may or may not move to the Cloud at a later date), Power BI Report Server is 
Microsoft’s on-premises solution.  It’s included with Power BI Premium and you can download a free trial at powerbi.microsoft.com/en-us/report-
server/#.

November saw the release of a new version of Power BI Report Server.  This release contained all of the features first introduced in the August 
Preview, as well as several new features:

	 •	 Scheduled data refresh
	 •	Direct Query support available
	 •	New REST API for developers
	 •	Connection to shared datasets via OData
	 •	 Filter reports using URL parameters.

Let’s go through each of these updates.

November 2017 Updates for Power BI Report Server
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Scheduled data refresh

With the August 2017 Preview of Power BI Report Server, Microsoft introduced the capability to upload Power BI reports that didn’t require an external 
connection to SQL Server Analysis Services. While this enabled the ability to view those reports on the server, it didn’t yet allow you to refresh the data 
feeding that report.  This has now been addressed.  Now, users may set data refresh schedules for their Power BI reports that are using any of more 
than 20 data sources.  This includes all the most popular data sources such as SQL Server, Oracle, Excel Workbooks, SAP HANA and many others.  It’s 
even possible to set multiple refresh schedules for each report, enabling even more control around how often you update your data.

In addition, the size of the files that may be uploaded to the server and scheduled for data refresh has been increased to 2 GB. 

Direct Query support available

New REST API for developers

Connection to shared datasets via OData

Filter reports using URL parameters

For reports that always need to look at the live source data, support has 
now been added for Direct Query.  It’s still limited, but it’s definitely a 
start.  So far, Direct Query is enabled in this release for SQL Server, Azure 
SQL Database, Oracle, Teradata, SAP HANA and SAP BW.  

All you need to do is choose the “Direct Query” option when creating 

your report in Power BI Desktop and load your report to the server.  
Once loaded, you can set the credentials used when connecting to the 
data source for report viewers or if you’d prefer to connect as the user 
viewing the report to take advantage of row-level security that’s also 
been set at the data level for certain data sources.

First introduced in SQL Server 2017 Reporting Services, a new, modern 
REST API for Report Server is now available.  Microsoft advises users to 
think of it as “…a RESTful successor to the legacy ReportingService2010 
SOAP API…”.  It has been extended to account for the additional report 
types supported in Power BI Report Server.

The REST API provides programmatic access to the objects in a report server 

catalogue: folders, reports, KPIs, data sources, datasets, refresh plans, 
subscriptions etc.  For example, using the REST API, you may navigate the 
folder hierarchy, discover the contents of a folder or download a report 
definition.  You can also create, update / delete objects, upload a report, 
execute a refresh plan, delete a folder, and so on.

Shared datasets in SQL Server Reporting Services have been used for 
years to enable the re-use of a single dataset across multiple reports and 
report types.  The functionality of the new REST API has been extended 
to also make these datasets available for use in Power BI reports via 

OData.  To connect to a shared dataset in your Power BI Reports, you 
can use the OData data source in Power BI Desktop and connect to the 
proper URL for your data source. 

Imagine you’ve embedded a Power BI report into another app using an iframe and a URL like the following:

https://reportserver/reports/powerbi/Store Sales?rs:Embed=true

Now you may specify additional filters using the “filter” URL parameter:

https://reportserver/reports/powerbi/Store Sales?rs:Embed=true&filter= Store/Territory eq 'NC' and 
Store/Chain eq 'Fashions Direct'

The syntax is similar to one that is used with the Power BI service.



We’re not done for the year yet.  December sees our global travels draw to a close with trips to Hong Kong, Johannesburg and New York.  If you’d 
like us to meet up with you, drop us a line at contact@sumproduct.com if you’d like to meet up.  We’d be happy to discuss your modelling / training 
requirements.

Sometimes we feel like we live on a plane…

Out and About in December

Long, long ago in Excel fora far, far away, a call went out to Excel users and gurus alike to vote for what they believed was the most useless function 
ever in Excel.  We reproduce the winner below – ahead of this month’s A to Z of Excel Functions.

The crowd favourite was FACTDOUBLE, a function we are sure most readers will have used on less than zero occasions.  This superstar of the 
modelling world returns the double factorial of a number (?).

Microsoft does like making terms up on occasion and we can’t help thinking this might be one such instance.  Mathematicians amongst you will 
know that the factorial function (denoted by ‘!’) only works with integers and is the product of all non-negative integers less than or equal to integer 
selected, e.g.

3! = 3 x 2 x 1 = 6

7! = 7 x 6 x 5 x 4 x 3 x 2 x 1 = 5,040

We thought FACTDOUBLE would therefore work as follows:

FACTDOUBLE(3) = 3!! = (3 x 2 x 1)! = 6! = 6 x 5 x 4 x 3 x 2 x 1 = 720

But no.

If n is odd, FACTDOUBLE(n) = n (n-2) (n-4)…3 x 1

If n is even, FACTDOUBLE(n) = n (n-2) (n-4)…4 x 2, e.g.

FACTDOUBLE(7) = 7 x 5 x 3 x 1 = 105

FACTDOUBLE(8) = 8 x 6 x 4 x 2 = 384

and therefore (!?) in Excel 2013, FACTDOUBLE(BITAND(13,25)) = 945 (erm…)

In fact, it will even work with non-negative decimals, the value is simply truncated so that it becomes a whole number.

Having said all this, since it was announced, various Excel users have been challenging each other to come up with a rationale for this function.  
Apparently, it is necessary to compute the odds of winning in Texas Hold ‘Em (obviously!) so it isn’t a function without use after all…

Blast from the Past: Most Useless Excel Function
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In probability theory and statistics, the chi-squared distribution (also chi-square or χ2-distribution) with k degrees of freedom is the distribution of 
a sum of the squares of k independent standard normal random variables.  It is one of the most widely used probability distributions in inferential 
statistics, e.g. in hypothesis testing or in construction of confidence intervals.  

The chi-squared distribution is used in the common chi-squared tests for goodness of fit of an observed distribution to a proposed theoretical one, 
the independence of two criteria of classification of qualitative data, and in confidence interval estimation for a population standard deviation of a 
normal distribution from a sample standard deviation. 

If Z1, ..., Zk are independent, standard normal random variables, then the sum of their squares

is distributed according to the chi-squared distribution with k degrees of freedom. This is usually denoted as

Thus, the chi-squared distribution has one parameter: k — a positive 
integer that specifies the number of degrees of freedom.

As aforementioned, the chi-squared distribution is used primarily in 
hypothesis testing.  Unlike more widely known distributions such as the 
normal distribution and the exponential distribution, the chi-squared 
distribution is rarely used to model natural phenomena.  It arises in the 
following hypothesis tests, among others.

The primary reason that the chi-squared distribution is used extensively 
in hypothesis testing is its relationship to the normal distribution.  Many 
hypothesis tests use a test statistic, such as the t statistic in a t-test.  For these 
hypothesis tests, as the sample size, n, increases, the sampling distribution 
of the test statistic approaches the normal distribution (Central Limit 
Theorem).  Since the test statistic (such as t) is asymptotically normally 
distributed, provided the sample size is sufficiently large, the distribution 

used for hypothesis testing may be approximated by a normal distribution.  
Testing hypotheses using a normal distribution is well understood and 
relatively easy.  The simplest chi-squared distribution is the square of a 
standard normal distribution.  So, wherever a normal distribution could be 
used for a hypothesis test, a chi-squared distribution could be used.

A chi-squared distribution constructed by squaring a single standard 
normal distribution is said to have 1 degree of freedom, etc.

The CHIDIST function returns the right-tailed probability of the chi-squared 
distribution. The χ2 distribution is associated with a χ2 test.  It is used to 
test the χ2 test to compare observed and expected values.  For example, a 
genetic experiment might hypothesise that the next generation of plants 
will exhibit a certain set of colours.  By comparing the observed results 
with the expected ones, you can decide whether your original hypothesis 
is valid.

The CHIDIST function employs the following syntax to operate:

CHIDIST(x , deg_freedom)
The CHIDIST function has the following arguments:
	 •	x: this is required and represents the value at which you want to evaluate the distribution
	 •	deg_freedom: this is also required. This represents the number of degrees of freedom (k).

It should be further noted that: 

	 •	 if either argument is nonnumeric, CHIDIST returns the #VALUE! error value
	 •	 if x is negative, CHIDIST returns the #NUM! error value
	 •	 if deg_freedom is not an integer, it is truncated
	 •	 if deg_freedom < 1 or deg_freedom > 10^10, CHIDIST returns the #NUM! error value
	 •	CHIDIST is calculated as CHIDIST = P(X>x), where X is a χ2 random variable

The A to Z of Excel Functions: CHIDIST
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	 •	 It should be noted that this function has been replaced with one or more new functions from Excel 2010 onwards (CHISQ.DIST.RT) that may provide 	
	 	 improved accuracy and whose names better reflect their usage.  Although this function is still available for backward compatibility, you should 	
	 	 consider using the new functions from now on, because this function may not be available in future versions of Excel.  This may require you to 	
	 	 amend existing models too.

Please see our example below:

The CHIINV function returns the inverse of the right-tailed probability of the chi-squared distribution.  If probability = CHIDIST(x,...), then 
CHIINV(probability,...) = x.  This function may be used to compare observed results with expected ones in order to decide whether your original 
hypothesis is valid.

The CHIINV function employs the following syntax to operate:

CHIINV(probability, deg_freedom) 

The CHIINV function has the following arguments:

	 •	probability: this is required and represents a probability associated with the chi-squared distribution
	 •	deg_freedom: this is also required. This represents the number of degrees of freedom.

It should be further noted that: 

	 •	 if either argument is nonnumeric, CHIINV returns the #VALUE! error value
	 •	 if probability < 0 or probability > 1, CHIINV returns the #NUM! error value
	 •	 if deg_freedom is not an integer, it is truncated
	 •	 if deg_freedom < 1, CHIINV returns the #NUM! error value
	 •	 It should be noted that this function has been replaced with one or more new functions from Excel 2010 onwards (CHISQ.INV.RT) that may 	
		  provide improved accuracy and whose names better reflect their usage.  Although this function is still available for backward compatibility, you  
		  should consider using the new functions from now on, because this function may not be available in future versions of Excel.  This may require  
		  you to amend existing models too.

Given a value for probability, CHIINV seeks that value x such that CHIDIST(x, deg_freedom) = probability.  Thus, the precision of CHIINV depends on 
the precision of CHIDIST.  CHIINV uses an iterative search technique.  If the search has not converged after a maximum of 100 iterations, the function 
returns the #N/A error value.

Please see our example below: 

The A to Z of Excel Functions: CHIINV

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

The chi-squared distribution is commonly used to study variation in the percentage of something across samples, such as the fraction of the day 
people spend reading these articles about obscure Excel functions.  This should not be confused with the CHIDIST function which returns the right-
tailed probability of the chi-squared distribution.

The CHISQ.DIST function employs the following syntax to operate:

CHISQ.DIST(x, deg_freedom, cumulative)

The CHISQ.DIST function has the following arguments:

	 •	x: this is required and represents the value at which you want to evaluate the distribution
	 •	deg_freedom: this is also required.  This denotes the number of degrees of freedom
	 •	 cumulative: this is another mandatory argument.  This is a logical value that determines the form of the function.  If cumulative is TRUE,  
		  CHISQ.DIST returns the cumulative distribution function; if cumulative is FALSE, it returns the probability density function. 

It should be further noted that: 

	 •	 if any argument is nonnumeric, CHISQ.DIST returns the #VALUE! error value
	 •	 if x is negative, CHISQ.DIST returns the #NUM! error value
	 •	 if deg_freedom is not an integer, it is truncated
	 •	 if deg_freedom < 1 or deg_freedom > 10^10, CHISQ.DIST returns the #NUM! error value.

Please see more examples below: 

The CHISQ.DIST.RT function returns the right-tailed probability of the chi-squared distribution. The χ2 distribution is associated with a χ2 test.  It is 
used to test the χ2 test to compare observed and expected values.  For example, a genetic experiment might hypothesise that the next generation 
of plants will exhibit a certain set of colours.  By comparing the observed results with the expected ones, you can decide whether your original 
hypothesis is valid.

The CHISQ.DIST.RT function employs the following syntax to operate:

CHISQ.DIST.RT(x, deg_freedom)

The CHISQ.DIST.RT function has the following arguments:

	 •	x: this is required and represents the value at which you want to evaluate the distribution
	 •	deg_freedom: this is also required.  This denotes the number of degrees of freedom.

It should be further noted that: 

	 •	 if either argument is nonnumeric, CHISQ.DIST.RT function returns the #VALUE! error value
	 •	 if any argument is nonnumeric, CHISQ.DIST.RT function returns the #VALUE! error value
	 •	 if deg_freedom is not an integer, it is truncated
	 •	 if deg_freedom < 1 or deg_freedom > 10^10, CHISQ.DIST.RT returns the #NUM! error value
	 •	CHISQ.DIST.RT appears to be the Excel 2010 replacement for the CHIDIST function.

Please see another example below: 

The A to Z of Excel Functions: CHISQ.DIST

The A to Z of Excel Functions: CHISQ.DIST.RT
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This function returns the inverse of the left-tailed probability of the chi-squared distribution.  The chi-squared distribution is commonly used to study 
variation in the percentage of something across samples, such as the fraction of the day people spend trying to understand what this function does.

The CHISQ.INV function employs the following syntax to operate:

CHISQ.INV(probability, deg_freedom)

The CHISQ.INV function has the following arguments:

	 •	probability: this is required and represents a probability associated with the chi-squared distribution
	 •	deg_freedom: this is also required.  This denotes the number of degrees of freedom.

It should be further noted that: 

•	 if either argument is nonnumeric, CHISQ.INV returns the #VALUE! error value
•	 if probability < 0 or probability > 1, CHISQ.INV returns the #NUM! error value
•	 if deg_freedom is not an integer, it is truncated
•	 if deg_freedom < 1 or deg_freedom > 10^10, CHISQ.INV returns the #NUM! error value.

Please see yet more examples below:

This function returns the inverse of the right-tailed probability of the chi-squared distribution.  If probability = CHISQ.DIST.RT(x,...), then CHISQ.INV.
RT(probability,...) = x. Use this function to compare observed results with expected ones in order to decide whether your original hypothesis is valid.

The CHISQ.INV.RT function employs the following syntax to operate:

CHISQ.INV.RT(probability, deg_freedom)

The CHISQ.INV.RT function has the following arguments:

	 •	probability: this is required and represents a probability associated with the chi-squared distribution
	 •	 deg_freedom: this is also required.  This denotes the number of degrees of freedom.

It should be further noted that: 

	 •	 if either argument is nonnumeric, CHISQ.INV.RT returns the #VALUE! error value
	 •	 if probability < 0 or probability > 1, CHISQ.INV.RT returns the #NUM! error value
	 •	 if deg_freedom is not an integer, it is truncated
	 •	 if deg_freedom < 1, CHISQ.INV.RT returns the #NUM! error value
	 •	CHISQ.INV.RT appears to be the Excel 2010 replacement for the CHIINV function.

Given a value for probability, CHISQ.INV.RT seeks that value x such that CHISQ.DIST.RT(x, deg_freedom) = probability.  Thus, precision of CHISQ.INV.
RT depends on precision of CHISQ.DIST.RT.  CHISQ.INV.RT uses an iterative search technique.  If the search has not converged after 64 iterations, 
the function returns the #N/A error value.  There aren’t many functions that stop at 64 iterations: we would be interested to know why this is the 
case here.

Another example: 

The A to Z of Excel Functions: CHISQ.INV

The A to Z of Excel Functions: CHISQ.INV.RT
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This function returns the test for independence.  CHISQ.TEST returns the value from the chi-squared (χ2) distribution for the statistic and the 
appropriate degrees of freedom.  You can use χ2 tests to determine whether hypothesised results are verified by an experiment.

The CHISQ.TEST function employs the following syntax to operate:

CHISQ.TEST(actual_range, expected_range)

The CHISQ.TEST function has the following arguments:

	 •	actual_range: this is required and represents the range of data that contains observations to test against expected values
	 •	expected_range: this is also required.  This denotes the range of data that contains the ratio of the product of row totals and column totals to  
		  the grand total.

It should be further noted that: 

•	 if actual_range and expected_range have a different number of data points, CHISQ.TEST returns the #N/A error value
•	 the χ2 test first calculates a χ2 statistic using the formula:

where:

	 	 o	 Aij = actual frequency in the i-th row, j-th column
	 	 o	 Eij = expected frequency in the i-th row, j-th column
	 	 o	 r = number or rows
	 	 o	 c = number of columns

	 •	 a low value of χ2 is an indicator of independence.  As can be seen from the formula above, χ2 is always positive or 0, and is 0 only if Aij = Eij for 	
	 	 every i and j
	 •	CHISQ.TEST returns the probability that a value of the χ2 statistic at least as high as the value calculated by the above formula could have 	
	 	 happened by chance under the assumption of independence.  In computing this probability, CHISQ.TEST uses the χ2 distribution with an 	
	 	 appropriate number of degrees of freedom, df.  
	 	 If r > 1 and c > 1, then df = (r - 1)(c - 1).  If r = 1 and c > 1, then df = c - 1 or if r > 1 and c = 1, then df = r - 1.  r = c = 1 is not allowed and #N/A is 	
	 	 returned
	 •	 the use of CHISQ.TEST is most appropriate when Eij’s are not too small.  Some statisticians suggest that each Eij should be greater than or equal 	
	 	 to 5
	 •	CHISQ.TEST appears to be the Excel 2010 replacement for the CHITEST function.

Please see the examples below: 

The A to Z of Excel Functions: CHISQ.TEST
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The CHITEST function

This function returns the test for independence.  CHITEST returns the value from the chi-squared (χ2) distribution for the statistic and the appropriate 
degrees of freedom.  You can use χ2 tests to determine whether hypothesised results are verified by an experiment.

The CHITEST function employs the following syntax to operate:

CHITEST(actual_range, expected_range)

The CHITEST function has the following arguments:

	 •	actual_range: this is required and represents the range of data that contains observations to test against expected values
	 •	expected_range: this is also required.  This denotes the range of data that contains the ratio of the product of row totals and column totals to  
		  the grand total.

It should be further noted that: 

	 •	 if actual_range and expected_range have a different number of data points, CHITEST returns the #N/A error value
	 •	 the χ2 test first calculates a χ2 statistic using the formula:

The A to Z of Excel Functions: CHITEST

where:

	 	 o	Aij = actual frequency in the i-th row, j-th column
	 	 o	Eij = expected frequency in the i-th row, j-th column
	 	 o	 r = number or rows
	 	 o	 c = number of columns

	 •	 a low value of χ2 is an indicator of independence.  As can be seen from the formula above, χ2 is always positive or 0, and is 0 only if Aij = Eij for 	
	 	 every i and j
	 •	CHITEST returns the probability that a value of the χ2 statistic at least as high as the value calculated by the above formula could have happened 	
	 	 by chance under the assumption of independence.  In computing this probability, CHITEST uses the χ2 distribution with an appropriate number 	
	 	 of degrees of freedom, df.  
	 	 If r > 1 and c > 1, then df = (r - 1)(c - 1).  If r = 1 and c > 1, then df = c - 1 or if r > 1 and c = 1, then df = r - 1.  r = c = 1 is not allowed and #N/A is 	
	 	 returned
	 •	 the use of CHITEST is most appropriate when Eij’s are not too small.  Some statisticians suggest that each Eij should be greater than or equal to 5
	 •	 It should be noted that this function has been replaced with one or more new functions from Excel 2010 onwards (CHISQ.TEST) that may provide 	
	 	 improved accuracy and whose names better reflect their usage.  Although this function is still available for backward compatibility, you should 	
	 	 consider using the new functions from now on, because this function may not be available in future versions of Excel.  This may require you to 	
	 	 amend existing models too.

Please see our final examples for this month below: 

More next month.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Upcoming SumProduct Training Courses

Location Course Date Duration

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Melbourne Excel Tips & Tricks 11th Dec 2017 1 day

Melbourne Financial Modelling 12th - 13th Dec 2017 2 days

Sydney Excel Tips & Tricks 15th Jan 2018 1 day

Sydney Financial Modelling 16th - 17th Jan 2018 2 days

Sydney Power Pivot, Power Query and Power BI 22nd - 24th Jan 2018 3 days

Melbourne Power Pivot, Power Query and Power BI 29th - 31st Jan 2018 3 days

Hobart Financial Modelling 5th - 6th Feb 2018 2 days

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Brisbane Excel Tips & Tricks 12th Feb 2018 1 days

Brisbane Financial Modelling 13th - 14th Feb 2018 2 days

Melbourne Excel Tips & Tricks 19th Feb 2018 1 day

Melbourne Financial Modelling 20th - 21st Feb 2018 2 days

Perth Financial Modelling 26th - 27th Feb 2018 2 days 

Sydney Visual Basic for Applications 12th Mar 2018 1 day

Sydney Power Pivot, Power Query and Power BI 19th - 21st Mar 2018 3 days

Adelaide Financial Modelling 5th - 6th Apr 2018 2 days 

Sydney Excel Tips & Tricks 23rd Apr 2018 1 day

Sydney Financial Modelling 26th - 27th Apr 2018 2 days

Melbourne Excel Tips & Tricks 30th Apr 2018 1 day

Melbourne Financial Modelling 1st - 2nd May 2018 2 day

Melbourne Power Pivot, Power Query and Power BI 14th - 16th May 2018 2 day

Auckland Financial Modelling 21st - 22nd May 2018 2 days

Wellington Financial Modelling 24th - 25th May 2018 2 days

Darwin Financial Modelling 4th - 5th Jun 2018 2 days

Sydney Power Pivot, Power Query and Power BI 18th - 20th Jun 2018 1 day 

Sydney Financial Modelling 25th - 26th Jun 2018 2 days

Have you heard about the SumProduct Referral programme? If you successfully introduce us to a client we will pay you 10% of the net profits of the 
engagement won upon receipt of client payment. Sounds like a pretty good deal to us!

Terms and conditions apply.  Referrer must be over 18 years of age, able to issue an invoice and not be an employee, director, agent or other related 
party of the client engaged.  For further information, drop us a line at  contact@sumproduct.com.  We hope to hear from you!

Referral Programme
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Sydney Address:	 SumProduct Pty Ltd, Suite 52, Level 10, 88 Pitt Street, Sydney, NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Level 9, 440 Collins Street, Melbourne, VIC 3000
Registered Address:	SumProduct Pty Ltd, Level 6, 468 St Kilda Road, Melbourne, VIC 3004

Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  Given its our five-year anniversary, 
here’s the most requested keyboards shortcut table – get CTRL of the shortcut alphabet:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

CTRL + A Select current region / all

CTRL + B Bold (toggle)

CTRL + C Copy

CTRL + D Fill down

CTRL + F Find dialog box

CTRL + G Go To dialog box

CTRL + H Replace dialog box

CTRL + I Italics (toggle)

CTRL + K Insert hyperlink

CTRL + L Excel 2007 / later: Create Table; Excel 2003 / earlier: Create List

CTRL + N New workbook

CTRL + O Open workbook

CTRL + P Print

CTRL + R Fill right

CTRL + S Save

CTRL + T Excel 2007 / later: Insert Table

CTRL + U Underline (toggle)

CTRL + V Paste

CTRL + W Close Window

CTRL + X Cut

CTRL + Y Redo

CTRL + Z Undo

mailto:contact@sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com
mailto:newsletter@sumproduct.com
mailto:contact@sumproduct.com
mailto:training%40sumproduct.com?subject=
http://www.sumproduct.com/training
http://www.sumproduct.com/thought/keyboard-shortcuts
http://www.sumproduct.com

